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Chapter 1

Introduction

OpenText Output Transformation Designer enables you to work with multiple
licensed OpenText products at the same time. Output Transformation Designer
contains a fully functional Java editor that enables the creation of plug-ins and
processes. With Output Transformation Designer, you are able to develop any type
of OpenText Output Transformation Suite solution without the need to open
another application from the suite.

The tabbed pane layout within the interface’s Development window enables you to
easily switch from one resource to another. You can save valuable time with the
ability to edit a custom component for one product, and then switching to another
tab to run the component.

1.1 Functional Summary
Output Transformation Designer assists developers and integrators with
implementing OpenText solutions. It provides an integrated graphical user interface
(GUI) for definition and configuration.

This includes, but is not limited to, the following functions:

• Defining any number of the following:

– File systems

– Environments

– Source event listeners

– Source data streams

– Destination data streams

– Process flows (a combination of individual processes)

– Individual processes (existing OpenText products and custom processes
written in Java)

– Locations of supporting resources

• Correlation of source data to destination data streams

• Deployment to target systems

• Configuration of logging and statistical profiles
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1.1.1 Target Users
Output Transformation Designer is designed primarily for novice and intermediate
users. The setting up of process flows and transformations can be a daunting and
intricate process. Output Transformation Designer enables novice users to easily
complete these tasks by using wizards, on-screen parameter descriptions, context
sensitive online help, and component templates. For the more experienced user,
Output Transformation Designer also enables the creation of custom Java code to be
used within all OpenText products.

Chapter 1   Introduction
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Chapter 2

About Output Transformation Designer Licenses

When OpenText Output Transformation Suite products are purchased, a license file
is created specifically for each contract. It includes information about who can use
the product, which product modules are available for use, and the number of
instances and jobs that can run concurrently. The license is tied to a specific release
and has an expiry date. As your needs change, your contract and licensing may
change as well.

You can view your license file by opening it with a text editor. Do not attempt to
modify the file. Changes will not take effect unless they are generated by OpenText
Licensing. An altered license file will no longer be valid and you will have to request
and/or deploy a valid license.

When you receive the license file, save it anywhere on your computer. Deploying
the license will place a copy of the file in the <install_home>\settings folder of
your installation directory.

Once the file has been deployed, the license file will be checked each time the system
is started. Details about the licensing of each product module will be written to the
log file (see“License Information in the Log File” on page 19).

2.1 Difference between Developer and Production
Modes
The software can run in one of two modes: Developer (for testing and verification)
or Production. Using any license with Output Transformation Designer, by default
you will be running in Developer Mode.

To ascertain the mode in which the product is running, refer to the license portion of
the log file, which will contain one of the following messages:

• If running in Production Mode:

Running in Production Mode. For Developer mode use -DXenosDevMode=true

• If running in Developer Mode:

Running in Developer Mode - NOT FOR PRODUCTION USE. For Production mode use
 -DXenosDevMode=false

All Output Transformation Engine jobs executed in Developer Mode will contain the
watermark:

Created by OpenText Embedded Output Transformation Engine
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To remove the watermark, you must disable Developer Mode and run Output
Transformation Designer in Production Mode. To do this, add the following runtime
argument in the DeveloperStudio.bootstrap file found in <install_home>\dev-
studio\bin:

-DXenosDevMode=false

Note: If you disable Developer Mode, you will need a license which allows
your machine to run the product in Production Mode.

2.2 Information in the License File
The following fields will exist in every license file:

LicenseType Production: A production license is used for
general deployment. Production licenses
generally expire every year.

OEM: Reserved for OpenText partners.

InternalUseOnly: These licenses are
generated and issued for internal use only.

IsTrial When set to true, indicates the license is a
trial license and not for production use. All
Output Transformation Engine jobs executed
with a trial license will contain a watermark
indicating that it is running in Dev Mode.

Customer Indicates the company name corresponding
to the contract.

Comment Contains any comments added by OpenText
Licensing.

OemKey Reserved for OpenText partners.

ConfigId This field is for internal use only by
OpenText Licensing.

LicenseId Contains a unique ID generated when a new
license is created, or if a license is modified
(new expiry date, machine name, etc.). The
LicenseId identifies this license file with
OpenText Licensing.

CreationDate The month, date and year the license file was
created.

Chapter 2   About Output Transformation Designer Licenses
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ExpireDate The month, date and year the license file
expires. The license expires at 12:00 A.M. on
this day.

Example:

 LicenseType = PRODUCTION

 Customer = Xenos

 Comment = 2011-Q3

 OemKey= ?-?-?

 ConfigId = QA-2011-Q3

 LicenseId = 11

 CreationDate...

     Day = 29

     Month = 6

     Year = 2011

 ExpireDate...

     Day = 1

     Month = 10

     Year = 2011

2.2.1 ProductInfo Section
Each licensed product module will have at least one section.

The following parameters exist in every product module section:

Product Specifies the product module name: Output
Transformation Engine (aka TS4DOCS,
Vision), Output Transformation Server (aka
EnterpriseServer), Data Transformation
Engine (aka TerminalOneTransform),
ebXML Messaging (aka
TerminalOneTransport), or Output
Transformation Designer (aka
DeveloperStudio).

Major Indicates the version numbers covered under
this license file. Example: Major=3

Minor If the product is licensed for more than one
version, each version number will have a
separate section in the license file.

Example (with Major=3): Minor=2 would
correspond to version 3.2.

2.2. Information in the License File
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AllowAlpha

AllowBeta

AllowGA

These fields will be marked =true or =false
depending on the code level allowed to run
under this license.

Alpha and beta are generally only for use
with IUO (Internal Use Only) licenses.

Components Lists all components covered under the
license for the product module.

MachineRefs Indicates the machine(s) that this licensed
product can be used on. If this field contains
* or the array is empty, then any of the
MachineInfo values (or DevMachineInfo
values, if running in Developer Mode) can be
used. This is ignored for Internal Use Only
(IUO) and Evaluation license types.

DevMachineRefs Same as MachineRefs (above), but used
when running in Developer Mode.

2.2.2 Parameters Unique to Specific Product Modules
Some parameters are exclusive to certain products.

2.2.2.1 Output Transformation Server

The following fields are used for Output Transformation Server exclusively:

ClusterMembers Specifies the number of Output
Transformation Server clusters that can be
run under this license.

Note: This indicates the number of
slave nodes in the cluster environment.

Crm If true, the Output Transformation Server
Configuration Manager can be used. If false,
it cannot.

Example:

 ProductInfo[2]...
     Product = Output Transformation 
Server (aka EnterpriseServer)
     ClusterMembers = 10
     Crm = true
     Major = 3
     Minor = 0
     AllowAlpha = true
     AllowBeta = true
     AllowGA = true
     Components[0] = ESBAJCPUB
    …
     MachineRefs[0] = *
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10 OpenText™ Output Transformation Designer VDTOTS240200-UTD-EN-1



Repository Features Parameters associated with the Archive
Navigator plug-in:

• DashboardMode. Determines which
value to use to limit the number of
Archive Navigator users at any given
time. GLOBAL uses the global
MaxDashboardUsers value,
INDIVIDUAL uses each licensed
adapter's MaxDashboardUsers value, and
BOTH checks both the Global and
Individual limits.

• ApiMode. Determines which value to use
to limit the number of API (non-Archive
Navigator) sessions allowed at any given
time. GLOBAL uses the global
MaxApiSessions value, INDIVIDUAL
uses each licensed adapter's
MaxApiSessions value, and BOTH checks
both the Global and Individual limits.

• MaxDashboardUsers. Indicates the
maximum number of users that can be
logged into the Archive Navigator at any
given time. A value of -1 means an
unlimited number of users.

• MaxApiSessions. Indicates the maximum
number of API (non-Archive Navigator)
sessions allowed at any given time. A
value of -1 means an unlimited number of
sessions.

• AdapterTypes. Specifies the licensed
adapter type: ESRE, Ibmod (IBM On
Demand), Filenet P8, Documentum,
CMIS, Isra (IBM Image Services), or
Custom. Each adapter has its own set of
parameters:

– MaxApplications. (Used only with
the ESRE adapter.) Indicates the
maximum number of Applications the
user is allowed to access. A value of -1
means an unlimited number of
Applications.

– IsLicensed. Specifies whether or not
the adapter is licensed for use.

– MaxAdapterInstances. Indicates the
maximum number of adapter types
that can be started in a single Output
Transformation Server instance at any
given time. A value of -1 means an
unlimited number of types.

– MaxDashboardUsers. Indicates the
maximum number of users allowed
per adapter at any given time. A value

2.2. Information in the License File
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of -1 means an unlimited number of
users.

– MaxApiSessions. Indicates the
maximum number of API sessions
allowed per adapter at any given time.
A value of -1 means an unlimited
number of sessions.

Example:

RepositoryFeatures...
    DashboardMode = GLOBAL
    ApiMode = GLOBAL
    MaxDashboardUsers = 10
    MaxApiSessions = 10
    AdapterTypes[0]...
      Type=ESRE
      MaxApplications = 100
      IsLicensed = true
      MaxAdapterInstances = 5
      MaxDashboardUsers = 1
      MaxApiSessions = 0
    AdapterTypes[1]...
      Type=Ibmod
      IsLicensed = true
      MaxAdapterInstances = 5
      MaxDashboardUsers = 1
      MaxApiSessions = 0
  AdapterTypes[2]...
    Type=Filenet
     IsLicensed = true
      MaxAdapterInstances = 5
      MaxDashboardUsers = 1
      MaxApiSessions = 0
    AdapterTypes[3]...
     Type=Documentum
      IsLicensed = true
      MaxAdapterInstances = 5
      MaxDashboardUsers = 1
      MaxApiSessions = 0
    AdapterTypes[4]...
      Type=Isra
      IsLicensed = true
      MaxAdapterInstances = 5
      MaxDashboardUsers = 1
      MaxApiSessions = 0
   AdapterTypes[5]...
      Type=CMIS
      IsLicensed = true
      MaxAdapterInstances = 5
      MaxDashboardUsers = 1
      MaxApiSessions = 0
    AdapterTypes[6]...
      Type=Custom
      IsLicensed = true
      MaxAdapterInstances = 5
      MaxDashboardUsers = 1
      MaxApiSessions = 0

Chapter 2   About Output Transformation Designer Licenses
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2.2.2.2 Output Transformation Server and Output Transformation Engine

The following fields are used for both Output Transformation Server and Output
Transformation Engine:

2.2. Information in the License File
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MaxJobsCoreOkay

MaxJobsCoreNotOkay

MaxJobsCoreOkay checks if the machine is
compliant with the maximum number of
cores licensed (as defined by the
MachineInfo/DevMachineInfo > Cores
parameter) and specifies the number of
concurrent jobs that can be run on a
compliant machine. Typically, the
MaxJobsCoreOkay value is set to -1
(unlimited).

MaxJobsCoreNotOkay specifies the
maximum number of concurrent jobs that
can be run on a non-compliant machine (i.e.
if the runtime machine contains more cores
than specified in the MachineInfo > Cores
parameter). Typically, MaxJobsCoreNotOkay
is set to 0 or 1. (If set to 0, Output
Transformation Server or Output
Transformation Engine will start, but no jobs
will run.) Additionally, if the number of jobs
is capped, Output Transformation Engine
jobs will be forced to be single-threaded.

Consider the following scenarios:

 

Scenario 1:

Licensed cores=4

MaxJobsCoreOkay=4

The machine has 4 cores.

Since the machine is compliant with the
Cores threshold (that is, licensed for 4 cores),
you can run up to 4 concurrent jobs as
specified by the MaxJobsCoreOkay value.

 

Scenario 2:

Licensed cores=1

MaxJobsCoreOkay=4

MaxJobsCoreNotOkay=2

The machine has 2 cores.

Since the machine is non-compliant and only
licensed to run 1 core, then the
MaxJobsCoreNotOkay value is used to
determine the maximum number of
concurrent jobs that can be run. In this case,

Chapter 2   About Output Transformation Designer Licenses
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you can run 2 jobs (single-threaded, if
running Output Transformation Engine).

If you upgraded the machine to 4 cores, the
machine is still non-compliant and the
MaxJobsCoreNotOkay value is used to limit
the number of jobs. Therefore you could still
run only 2 jobs (single-threaded, if running
Output Transformation Engine).

If you downgraded the machine to 1 core, the
machine is in compliance and the
MaxJobsCoreOkay value is used. Therefore
you could run 4 jobs.

 

Scenario 3:

Licensed cores=4

MaxJobsCoreOkay=4

MaxJobsCoreNotOkay=1

The machine has 2 cores.

Since the machine is compliant with the
Cores threshold (licensed for 4 cores), you
can run up to 4 concurrent jobs as specified
by the MaxJobsCoreOkay value.

If you upgraded the machine to 4 cores, the
machine is still compliant with the Cores
threshold. Therefore you could still run 4
jobs.

If you upgraded the machine to 6 cores, the
machine is no longer compliant and the
MaxJobsCoreNotOkay value is used to limit
the number of jobs. Therefore you could run
only 1 job (single-threaded, if running
Output Transformation Engine).

Example:

 Product = Output Transformation Engine 
(aka TS4DOCS, Vision)

     MaxJobsCoreOkay = -1

     MaxJobsCoreNotOkay = 1

     Major = 4

     Minor = 0

     AllowAlpha = true

     AllowBeta = true

2.2. Information in the License File

VDTOTS240200-UTD-EN-1 User Guide 15



     AllowGA = true

     Components[0] = VBVRC

     …

     MachineRefs[0] = *

2.2.2.3 Data Transformation Engine

 No unique fields.

Example:

 ProductInfo[5]...

     Product = Data Transformation (aka 
TerminalOneTransform)

     Major = 6

     Minor = 3

     AllowAlpha = true

     AllowBeta = true

     AllowGA = true

     Components[0] = Cobol

     …

     MachineRefs[0] = *

2.2.2.4 Output Transformation Server ebXML Messaging

 No unique fields.

Example:

 ProductInfo[5]...

     Product = ebXML Messaging (aka 
TerminalOneTransport)

     Major = 3

     Minor = 0

     AllowAlpha = true

     AllowBeta = true

     AllowGA = true

     Components[0] = ebXml

     …

     MachineRefs[0] = *

Chapter 2   About Output Transformation Designer Licenses
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2.2.2.5 Output Transformation Designer

 No unique fields.

Example:

 ProductInfo[5]...

     Product = Output Transformation 
Designer (aka DeveloperStudio)

     Major = 3

     Minor = 0

     AllowAlpha = true

     AllowBeta = true

     AllowGA = true

     Components[0] = 0 items.

     …

     MachineRefs[0] = *

2.2.3 MachineInfo Section
If this license has been generated for use on a specific machine, or by a specific user,
the information about those restrictions will appear in the MachineInfo section.

Note: Evaluation and IUO (Internal Use Only) licenses do not check the
MachineInfo values. These license types may run on any machine.

HostId This value must match the host ID of the
machine. The value “*” will match any host
ID.

UserId This value must match the machine logon
user ID. The value “*” will match any user
ID.

Cores Specifies the number of processors available
to the JVM. A value of -1 means unlimited. If
the product is licensed for a maximum
number of cores, the machine is checked on
Output Transformation Server startup. (For
hyper-threaded cores, a machine may have 4
physical cores but Java will report this as 8
cores.)

This field is also used to determine the
MaxJobsCoreOkay and
MaxJobsCoreNotOkay parameters for
Output Transformation Server and Output
Transformation Engine.

2.2. Information in the License File
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MaxInstances If there are restrictions on the number of
instances of Output Transformation Server
that can be run concurrently, this will be
checked on startup.

ReservedPortNumber Specifies the port number reserved for the
license file. This ensures that no more than
the MaxInstances of Output Transformation
Server or Output Transformation Engine are
running at any given time on the machine.
The default value is set to 7771, but can be
changed when the license is generated.

Note: Ensure that the
ReservedPortNumber specified in the
license file is available for the product's
use. If the port is being used for
another application, a new license can
be requested with an updated
ReservedPortNumber.

Example:

 MachineInfo[]...

     HostId = *

     UserId = *

     Cores = 10

     MaxInstances = 1

     ReservedPortNumber = 7771

2.2.4 DevMachineInfo Section
This section contains the same parameters as described in the MachineInfo section,
but is used when running in Developer Mode.

Note: Versions of Output Transformation Server and Output Transformation
Engine prior to version 4.0 may still use the DevUserIds parameter, which
specifies the machine logon user IDs when running in Developer Mode. This
parameter has since been replaced by the DevMachineInfo > UserId parameter.

Chapter 2   About Output Transformation Designer Licenses
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2.2.5 UsageTrackingRequirements Section
This section contains settings to control the collection of usage statistics.

DocPagesUsage If set to true, then Output Transformation
Engine usage statistics will be collected. Note
that when this option is enabled, Output
Transformation Engine jobs will not start
unless both the DocPages Summary log and
the CS Transaction log are active and
without error. See the OpenText Output
Transformation Server - User Guide (VDTOTS-
H-UGD) for more information.

Example:

 UsageTrackingRequirements...

     DocPagesUsage = true

2.2.6 Generated Hash Encrypted Output
The machine-readable information about the license file is in the encrypted
information at the bottom of the license file. If this data is compromised in any way,
the license will not deploy and you will need to deploy or request a new license file.

2.3 License Information in the Log File
On startup, the Output Transformation Server license file is checked and details are
logged in the log file. For Output Transformation Server products, the license details
can be found in Output Transformation Designer under _logs > Debug > all-debug.
textreport. For standalone Output Transformation Engine, the license details are
written to the Output Transformation Engine System log file: <install_home>
\initialfiles\common\_sample\OutputTransformation\reports\system.log.

Note: The license portion of the log file can be validated by OpenText
Licensing to ensure that it has not been tampered with.

The following is an example of an InternalUseOnly license running in Production
Mode:
 *** DateTime: 2012-10-18_10:31 (EDT)
 ***
 *** LICENSE
 *** ====================
 *** LicenseType: InternalUseOnly
 *** Customer: Xenos
 *** LicenseId: 69
 *** ConfigId: 2012-Q4
 *** License expires on: 2012-12-31 (in 73 days)
 *** Serial: v01-0004-0004-69-ffff
 *** MaxInstances: Unlimited
 *** (i) Running in Production Mode.
 ***     For Developer mode use -DXenosDevMode=true
 *** SERVER
 *** ====================

2.3. License Information in the Log File
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 *** Host: abl07123 (abl07123.example.com)
 *** User: ablack
 *** Processors: 4
 ***
 ***
 *** INSTALLED PRODUCTS
 *** ====================
 *** Product: Output Transformation Designer (aka DeveloperStudio) - 4.0.02_2012-09-21d 
(build 1128)
 *** Product: Output Transformation Server (aka EnterpriseServer) - 4.0.02_2012-09-21d 
(build 1128)
 *** Product: Output Transformation (aka TS4DOCS, Vision) - 4.0.02_2012-09-21d (build 
1128)
 *** Product: Data Transformation (aka TerminalOneTransform) - 6.5.02_2012-09-21b (build 
1128)
 *** Product: ebXML Messaging (aka TerminalOneTransport) - 4.0.02_2012-09-21d (build 
1128)
 ***
 *** JVM PROPERTIES
 *** ====================
 *** java.vm.version = 19.1-b02
 *** java.vm.vendor = Sun Microsystems Inc.
 *** java.class.version = 50.0
 *** java.specification.version = 1.6
 *** user.country = US
 *** user.language = en
 *** user.home = C:\Users\ablack
 *** user.timezone = America/New_York
 *** os.arch = x86
 *** os.name = Windows 7
 *** os.version = 6.1
 ***
 *** JVM Options:
 ***    -Xms128m
 ***    -Xmx512m
 ***    -XX:MaxPermSize=256m
 ***    -Djava.security.auth.login.config=..\..\lib\auth.conf
 ***
 ********************************************** END:ES 
hash="83b28b573865390232e134e7aa08344bfd3"***

2.4 Storing a Renewed or Updated License
The license key files OpenText Licensing sends you when you update or renew an
OpenText product are used to:

• Grant permission to use the licensed product suite.

• Deploy the license key files for future validation purposes.

Store the renewed or updated license anywhere on your computer system when you
receive it. For future validation purposes, when you deploy a license to Output
Transformation Designer or an application server, your license file is stored in the
<install_home>\settings folder.

Chapter 2   About Output Transformation Designer Licenses
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2.5 Deploying a Renewed or Updated License
Any time you receive a renewed or updated license key file (or simply license) for an
installed product from OpenText Licensing, the license must be redeployed for it to
be stored, for example, your license expired and you have to renew it. For more
information, see “Storing a Renewed or Updated License” on page 20

Redeploy an updated or renewed license key file to:

• Output Transformation Designer

• An application server. For more information, see “Deploying a Renewed or
Updated License to an Application Server” on page 22.

Either way enables you to deploy the new license at the same time.  However, they
are independent of each other. Output Transformation Designer doesn’t need a valid
license for the server to run properly and the application server doesn’t need a valid
license for Output Transformation Designer to work properly.

2.5.1 Deploying a Renewed or Updated License to Output
Transformation Designer
To deploy an updated or renewed license key using Output Transformation
Designer:

1. Open Output Transformation Designer.

2. Choose Help > About, and select the License tab.

The License tab displays. The list of licenses is on the left side and default
information for the license appears on the right.

3. Select your product license from the list below the License node. The license
file’s location and its expiry date are displayed for the selected license.

4. Click Deploy New License to open the Deploy New License dialog.

5. Navigate to the location where you stored the license received from OpenText
Licensing.

6. Click Deploy.

The license file stored in the <install_home>\settings folder is updated with
the new license.

2.5. Deploying a Renewed or Updated License
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2.5.2 Deploying a Renewed or Updated License to an
Application Server
You can deploy a new license to an application server through either Output
Transformation Designer or Output Transformation Server Manager.

2.5.2.1 Using Output Transformation Designer

To deploy an updated or renewed license key to an application server using Output
Transformation Designer:

1. Start Output Transformation Designer.

2. Click the Connections tab.

3. Right-click the server node you want to deploy a license to.

Note: If you do not have a server set up yet, you will need to set up an
application server. For more information, see OpenText Output
Transformation Server - User Guide (VDTOTS-H-UGD). If you want to add
another server, see Adding Servers in OpenText Output Transformation
Server User Guide.

4. Select Information from the context menu.

5. In the Information dialog, click the License tab.

6. Click Deploy New License to see the Deploy New License dialog showing
your current folders.

7. Locate the new license and click Deploy.

Your new license is now deployed to the <install_home>\settings folder,
which is the default system location for licenses.

2.5.2.2 Using the OpenText Output Transformation Server Manager

To deploy an updated or renewed license key to an application server using the
Output Transformation Server Manager:

1. Start Output Transformation Server Manager.

2. Click the Info tab and select License to open the License screen.

3. Click Browse and locate the new license.

4. Click Deploy to deploy the new license. You might need to reload the page to
see the license’s valid date extended.

The license file stored in the <install_home>\settings folder is updated with
the new license.

For more information on licenses, see OpenText Output Transformation Server Manager
User Guide.
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Note: : Before you can deploy a license on an application server, you must set
up an application server. See OpenText Output Transformation Server - User
Guide (VDTOTS-H-UGD) for more information.

2.6 Setting up Core Binding
On machines running Windows, licenses for the product check the number of cores
on your machine because there is a maximum number of cores that can be used to
process jobs, which varies depending on your license type. If there is a discrepancy
between the number of cores, the application will not allow you to execute any jobs.
When upgrading hardware, you may encounter a situation where the new machine
is more powerful than the previous one, resulting in a mismatch between the
number of cores you are licensed for and the number of cores in your machine. In
these circumstances, you must set processor affinity to run jobs with only a subset of
available cores.

There are two ways of setting core binding and each method is illustrated using the
same example of binding to cores 0 and 4 on an 8-core machine.

Within Output Transformation Designer

When deploying a new license to Output Transformation Designer, the product
checks the number of cores on the machine and verifies how many cores the license
allows. If the license only permits fewer cores than what is on the machine, the
Processor Affinity dialog box appears where you are shown the number of cores
you are licensed for and you must choose which cores you want to bind to.

2.6. Setting up Core Binding
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Figure 2-1: Processor Affinity dialog box with CPUs 0 and 4 selected

Modifying the setAffinity Batch File

Navigate to the <OTS_home>\settings\ directory and open the setAffinity.bat file
for editing in your preferred text editor. Then, calculate the sum from the values that
correspond to the cores to use on your machine according to the table and convert it
to a hex value.

Table 2-1: 

Processor/Core ID Value

CPU 0 1

CPU 1 2

CPU 2 4

CPU 3 8

CPU 4 16

CPU 5 32

CPU 6 64

CPU 7 128
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For example, if you want to bind to CPU 0 and CPU 4 you must add their values
together (1 + 16) and with then convert the sum (17) to a hexadecimal value, which is
11 (hex calculators can be found online to perform the conversion). Use this final
value in the setAffinity.bat file:

set OTS_AFFINITY=11

2.7 Troubleshooting Licensing Issues
Problem or Log Message Result Solution

License has expired. Output Transformation
Designer will start, but will
present an error message and
open an explorer window to
deploy a different license file.

Note: When a license
file has less than 30
days remaining to
expiry, each startup
will produce a warning
message: “WARNING!!
License will expire in
NN days.”

Request and deploy a new
license file. Contact
OpenText Licensing at
support@opentext.com.

License invalid or may be
corrupted (code). Please
contact OpenText Licensing
for a valid license.

Output Transformation
Designer will start, but will
present an error message and
open an explorer window to
deploy a different license file.

Request and deploy a new
license file. Contact
OpenText Licensing at
support@opentext.com..

Too many instances running;
unable to secure port starting
with port <port number>.

The system tests the number
of ports specified in
MaxInstances, starting with
the ReservedPortNumber.

For example, if MaxInstances
= 5, and
ReservedPortNumber = 7771,
then ports 7771 through 7775
are tested. If none of these
ports are available, then
either 5 instances are already
running, or another program
is using the port.

Ensure that the
ReservedPortNumber
specified in the license file is
available for the product’s
use. If the
ReservedPortNumber is
outdated, a new license can
be requested with an
updated
ReservedPortNumber.

2.7. Troubleshooting Licensing Issues
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Problem or Log Message Result Solution

UserId <user ID> does not
match any of the licensed
Developer User IDs - license
not valid for this user.

The license is for running in
Developer Mode, but the
user is not registered under
the DevMachineInfo > UserId
parameter.

The user is not included in
the list of valid developer
users, in accordance with the
license agreement. The user
must have a validated user
ID. If the list of developer
users is outdated, a new
license can be requested with
updated user IDs.

License is not valid for
host=<host ID>, user=<user
ID>

The machine host name
and/or the user name do not
correspond to the
MachineInfo parameters
HostId and UserId in the
license file.

The product must be
installed and licensed on the
machine specified in the
license file by the user
specified in the license file. If
the information specified in
the license file is incorrect,
request a new license file.

Code has expired. The evaluation period of this
evaluation build/license
combination has expired. The
product will not run.

Once the evaluation period is
over, you need to upgrade to
a production build and
license. In some
circumstances a new
evaluation build and license
may be issued.

One of the following
messages appears:

Evaluation license cannot be
used with Standard build
type.

Evaluation license required
to run an evaluation build.
 (Note: IUO license may run
an Evaluation build.)

Your license does not allow
you to run this build type.

There is a mismatch between
the product build and the
license type.

The product will not run.

You require a new product
build, a new license file, or
both. Contact OpenText
Licensing at
support@opentext.com.
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Problem or Log Message Result Solution

One of the following
messages appears:

Your license does not allow
code level Alpha to run.

Your license does not allow
code level Beta to run.

Your license does not allow
code level GA to run.

Internal use only license is
required with this code level.

There is a mismatch between
the code level and the
licensed code level.

The product will not run.

You require a new product
build, a new license file, or
both. Contact OpenText
Licensing at
support@opentext.com.

Cannot run on this machine,
host=<host ID>

The license file restricts the
machines that the product
can be run on. This machine
is not specified as a valid
machine in the license file.

Install and run the product
on the machine specified in
the license file, or request and
deploy a new license file that
corresponds to this machine.

This product is not licensed. The product will not run. The product is not included
in the list of valid products.
Deploy or request a valid
license file.

Build-type non-standard -
Not for production use!

This is either an evaluation
build or an unofficial build,
neither of which can be used
with a standard license.

You require either an
evaluation license or a new
product build. Contact
OpenText Licensing at
support@opentext.com.

Code-level non-GA - Not for
production use!

This is an Alpha or Beta
build, neither of which can be
used for production. The
software will still run, but
only for testing purposes.

You require a GA build when
available. Contact OpenText
Licensing at
support@opentext.com.
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Problem or Log Message Result Solution

System warning (x.y.z)

or

System error (x.y.z)

These messages appear when
the number of available cores
exceeds the allowed number
of cores.

For (x.y.z):

x = MaxJobsCoreNotOkay

y = Number of cores on
machine

z = Number of cores allowed.

In the example (2.8.4), the
number of available cores (8)
exceeds the number of
allowed cores (4), and the
maximum number of jobs
allowed when the machine is
non-compliant is 2. Therefore
2 jobs will be able to run, and
the message will be issued as
a warning.

In the example (0.8.4), the
number of available cores (8)
exceeds the number of
allowed cores (4), and the
maximum number of jobs
allowed when the machine is
non-compliant is 0. No jobs
will be able to run, and the
message will be issued as an
error.

Run the program as-is or
install and run the program
on a compatible machine.

If this restriction causes
production problems, you
may wish to consider
modifying your contract to
better suit your needs and
environment.

The Output Transformation
Engine output has a
watermark.

Product is running in
Developer Mode and is not
for production use or you are
using an evaluation build
with an evaluation license.

If you are using a production
license, the watermark will
not appear when deployed in
production.

If you are using an
evaluation build, you will
always see a watermark on
the output as the build and
license are not intended for
production use.
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Chapter 3

Output Transformation Designer menus and
toolbars

Output Transformation Designer has a menu bar and several toolbars available.

The main menu bar is located across the top of the Output Transformation Designer
interface. It contains the following options:

• “File menu” on page 29

• “Edit menu” on page 30

• “View menu” on page 31

• “Environment menu” on page 32

• “Build menu” on page 32

• “Tools menu options” on page 33

• “Window menu” on page 38

• “Help menu” on page 39

• “Toolbars” on page 40

3.1 File menu
The File menu contains all of the options for opening, closing, printing, and saving
your transformation projects. Output Transformation Server allows you to have
more than one project open at a time in Output Transformation Designer.

Icon Menu Command Keyboard Shortcut Description

New Ctrl + N Starts a new project
without closing any
projects already open
in Output
Transformation
Designer.

Open Ctrl + O Opens a project from
your file system
without closing any
projects already open
in Output
Transformation
Designer.
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Icon Menu Command Keyboard Shortcut Description

 Open Recent None available Allows you to
quickly open one of
the most recently
opened files. The
default is set to 10,
but this can be
changed under
Preferences.

Save Ctrl + S Saves the current
project component to
disk. You will be
prompted for a
project name if not
already given.

Save As None available Allows you to save
the current project in
a different folder, or
using a different
name.

Save All None available Saves all components
of the current project
to disk.

Print None available Prints the template
file of the current
project.

Exit None available Closes the Output
Transformation
Designer application.

3.2 Edit menu
The Edit menu provides commands which enable you to cut and paste items in
various Output Transformation Designer windows.

Icon Menu Command Keyboard Shortcut Description

Cut Ctrl + X Removes a selected
item, and saves it to
the clipboard.

Copy Ctrl + C Saves a copy of
selected item(s) to the
clipboard.

Paste Ctrl + V Pastes the saved
content of the
clipboard to a
selected location.
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Icon Menu Command Keyboard Shortcut Description

Delete Delete Deletes the selected
item.

Undo Ctrl + Z Removes the last
modification
performed and
reverts it to the
previous state. Where
available, the undo
feature is limited to
the last 5 steps.

Redo Ctrl + Y Redoes the most
recently undone
action in the current
project.

Find Ctrl + F Searches for a string
of alphanumeric
characters within the
opened project.

3.3 View menu
The View menu provides options for customizing the toolbars shown in the
graphical interface, and mappings of Output Transformation Designer.

Icon Menu Command Description

 Toolbars Toggles the available toolbars
on and off. The toolbars
permit quick and easy access
to frequently used menu
commands. Toolbars
available include: File, Edit,
View, Build, Debug, Run and
Help. For more information
on toolbars, see “Toolbars”
on page 40.

 Log Opens the Output
Transformation Designer log
(application.log) file.

Collapse All Collapses the expanded
directory file structure
beneath the currently
selected folder in the File
System window.

Expand All Opens all subdirectories
below the selected folder in
the file structure hierarchy in
the File System window.

3.3. View menu
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3.4 Environment menu
The Environment menu provides all of the options available for managing Output
Transformation Designer environments and their users. For more information, see
“Output Transformation Designer Environments“ on page 59.

Menu Command Description

User Administration This choice is only enabled when the
configuration repository is started. It enables
the administrator to create and manage user
accounts for those users who will have access
to the configuration repository system.

Output Transformation Engine System
Manager

Launches the Output Transformation Engine
System Manager.

From the Output Transformation Engine
System Manager you can open any Output
Transformation Engine system configuration
file, or change the default system
configuration file used for Output
Transformation Engine projects. For more
information, see OpenText Embedded Output
Transformation Engine - User Guide (VDTOTS-
H-UTE).

3.5 Build menu
The commands available in the Build menu are component dependent. They assist
in the creation of custom components.

Icon Menu Command Keyboard Shortcut Description

Compile F9 Compiles the selected
component.

Debug F5 Debugs the selected
component.

Execute None available Executes the
commands within a
selected component.
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3.6 Tools menu
The Tools menu provides commands for setting preferences, deploying projects,
and launching supplementary applications. Further product settings are available to
be configured under Preferences.

3.6.1 Tools menu options

Icon Menu Command Description

Preferences Opens the “Preferences”
on page 35 window where
you can set your options for
various program-wide
aspects such as appearance,
logging, supporting editors,
and Java settings.

Base64 Tool Performs encoding or
decoding of Base64 encoded
strings or files. For more
information, see “Using the
Base64 Tool” on page 34.

 Deploy to Output
Transformation Server

Deploys a packaged Output
Transformation Server
project to the server. For
more information, see
OpenText Output
Transformation Server - User
Guide (VDTOTS-H-UGD).

New Custom Component Launches the New
Component Wizard to set up
a new custom component.

 User Administration Allows an administrator to
manage user accounts for
users who have access to the
configuration repository
system. This option is
unavailable unless a
configuration repository is
started.

 Configuration Manager Allows you to connect to a
Configuration Manager
instance.

New Output Transformation
Engine Project

Launches the New
Component Wizard to set up
a new Output
Transformation Engine
project.

3.6. Tools menu
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Icon Menu Command Description

 Output Transformation
System Manager

Launches the Output
Transformation System
Manager, which helps you
manage Output
Transformation Engine
system configuration files.
For more information, see
OpenText Embedded Output
Transformation Engine - User
Guide (VDTOTS-H-UTE)

New Data Transformation
Project

Launches the New
Component Wizard to set up
a new Data Transformation
Engine project.

3.6.2 Using the Base64 Tool
The Base64 Tool is an embedded function that can encode/decode strings or files
with the Base64 encoding scheme.

To use the Base64 Tool:

1. Navigate to Tools > Base64 Tool to open it on a new tab in the Development
window.

2. In the Mode drop-down list, select whether you want to run Encode or Decode
mode.

3. In the From Input Type drop-down list, select the type of input you are using.
You can choose from either String or File.

4. If you selected String as the input type, you either type or copy and paste the
string into the Enter Input String field.

If you selected File as the input type, you can either type the file path location to
your file or click the ellipses, , beside the Select Input File field to locate
your input file. If you typed in a file path location, the path to the file shown is
relative to the Output Transformation Designer working directory. However, if
you selected a file then the Select Input File field displays the absolutely
location of the file within the file system. Regardless of the file selection method
used, the first 1 KB of the file is shown in the Input File Preview section to
allow you to inspect the file’s contents without having to open the whole file in
a separate editor.

5. Next, using the To Output Type drop-down list, you must indicate the type of
output you want. You can choose from either String or File.

6. If you selected String as the output type, proceed to the next step.

If you selected File as the output type, click the ellipses, , beside the Select
Output File field and indicate the file path location for the output file. You can
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choose an existing output file or if you want to create a new file, type the
absolute file path location. If you do not type in an absolute location, a relative
path based on Output Transformation Designer’s working directory is used.
Also, use the Overwrite Output File check box to designate whether you want
to allow the overwriting of your output files.

7. Click Execute.

If the output type is set to String, the encoded/decoded output is shown in the
Output String field. Optionally, you can click Copy To Clipboard to copy the
contents of the Output String field for pasting in other applications.

If the output type is set to File, the encoded/decoded output is directed to your
previously specified file path location. Also, the first 1 KB of the file is shown in
the Output File Preview section and the output directory can be displayed by
clicking View Output Directory.

3.6.3 Preferences
The Preferences section organizes different types of options on separate tabs.

3.6.3.1 General tab

The General tab contains various options grouped by the areas they affect.

Appearance

The Appearance tab allows you to modify how or which elements are displayed.

• HideWelcome. By default, the Welcome screen opens when Output
Transformation Designer is started. Turn off this option by selecting Hide
welcome on next start on the Welcome screen, or by clearing the HideWelcome
checkbox in the Appearance pane. To reenable this feature, select the checkbox.

• UnicodeDisplayFont. Enter the path to the Unicode display font required to
view double-byte characters.

• RecentFilesCount. Defines the number of recently opened files to display in the
File menu.

• ShowAllComponents. Indicates whether to show all components or only the
components you are licensed for in the interface. By default, this parameter is
enabled and all components are shown.

Diff Tool

The Diff Tool tab specifies options for the data comparison tool to use.

• DiffTool. Specifies the file path to the data comparison tool used for displaying
the differences between file contents.

3.6. Tools menu
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Logging

The Logging tab specifies options related to the log files generated by the
application.

• MaxSize. The default maximum log file size is 10 MB. When the log file reaches
this limit, this log file will be renamed and a new one will begin.

• MaxFiles. Set the maximum number of log files to archive. When the limit is
reached, the oldest log file will be deleted when a new log file is created.

For more information about log files, see “Output Transformation Designer
Logging“ on page 65.

Dialogs

The Dialogs tab specifies options related to the position and size of dialog boxes.

Default dimensions and screen positions can be set for dialog boxes, according to
their category, and their respective settings are saved and will persist following a
restart of the application. Moreover, settings from manually resizing or moving a
dialog box are also saved here. The following values can be set for dialog boxes:

• Name. Indicates the name of the dialog box category. These category names are
automatically added after a corresponding dialog box is opened in the
application.

• Dimension. Specifies the default dimensions for dialog boxes in the specified
category. Dimension settings are also saved if you manually resize a dialog box.

• Location. Denotes the default screen position of the dialog box.

Output Window

The Output Window tab contains options related to the Log tab on the Output pane.

• OutputBufferSize. Specifies the maximum size, in kilobytes, of the log shown on
the Log tab on the Output pane before it is automatically cleared.

XFT

The XFT tab contains an option to dictate the default unit of measurement for the
XFT Field Technology component.

• ViewCoordinateUnits. Denotes the unit of measurement to use when viewing
coordinates in previews. When viewing pages in the Page View mode or
defining fields in the XFT Field Technology component, the selected units will be
the default coordinate units. The default coordinate units can also be changed
while in the Page View mode or XFT Field Technology component by right-
clicking the X or Y coordinate displays at the bottom right of the viewing
window.
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Hex View

The Hex View tab contains options controlling the visibility of certain elements
when working in the hex viewer.

• Decimal. Indicates whether decimal points for numbers are displayed.

• ASCII. Indicates whether an ASCII column is displayed to show ASCII code.

• EBCDIC. Indicates whether an EBCDIC column is displayed to show
hexadecimals translated into EBCDIC format.

• Octal. Indicates whether an EBCDIC column is displayed to show hexadecimals
translated into octal numbers.

• Columns. Specifies the number of hexadecimals to display within each row in
the Hexadecimal column. The value has a default of 16, but must have a
minimum value of 4.

Resource Management

The Resource Management tab contains options related to the Resource Manager
cache.

• ClearCache. Specifies whether the Resource Manager cache is cleared before a
job is executed. Being able to review the cache can be helpful when trying to
troubleshoot issues. By default, clearing the cache is enabled.

3.6.3.2 Editors tab

The Editors tab is broken down into two subsequent sections.

File Types  

The File Types tab allows you to manage file types and their associated file
extensions.

• File Types. Each file type is automatically associated with one or more file
extensions, which are displayed in the Extension List.

• To add additional file extensions, choose the appropriate file type, enter the file
type extension in the Extension box, and click Add, .

• To overwrite a file extension in the Extension List with a new file extension,
choose the appropriate file type, select the extension from the Extension List,
type a new file extension, and click Edit, .

• To remove a file extension from the list, choose the appropriate file type, select
the extension from the Extension List, and click Delete, .

Cell Editor

The Cell Editor tab contains system-wide preferences for the cell editors.

3.6. Tools menu
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• DefaultEditorMode. Indicates the default mode to display when a cell editor is
launched. You can choose from the following modes:

– Auto. Denotes that the cell editor can automatically switch between
Expression and Text modes, depending on the content shown. This is the
default setting.

– Expression. Denotes that the cell editor displays Expression mode by default,
which allows you to easily add functions and variables to your expression.

– Text. Denotes that the cell editor displays Text mode by default, which allows
you to type in your values.

• ExpressionLayout. Designates the layout of expression graphs. You can choose
from LEFT_TO_RIGHT, RIGHT_TO_LEFT, TOP_TO_BOTTOM, or
BOTTOM_TO_TOP. By default, graphs are shown using LEFT_TO_RIGHT
layouts.

3.6.3.3 Java tab

The Java tab contains options for Java home settings and virtual machines.

Java Settings

• JavaHome. Enter the path to the directory where the Java Developers Kit (JDK) is
installed. If you did not install the JDK option with Output Transformation
Server, you need to set JavaHome to the location of your JDK installation.

• VmOptions. Click to add options that will be passed to the virtual machine
(VM), if required.

3.7 Window menu
The Window menu enables you to open and close projects opened within Output
Transformation Designer.

Icon Menu Command Keyboard Shortcut Description

File System None available Opens or selects the
“File Systems
Window”
on page 46 as the
active window.

Connections None available Opens or selects the
Connections tab in
the “File Systems
Window”
on page 46 as the
active window.
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Icon Menu Command Keyboard Shortcut Description

Events None available Opens or selects the
“Events Window”
on page 57 as the
active window.

Debug None available Opens or selects the
Debug tab in the
“Events Window”
on page 57 as the
active window.

Properties None available Opens or selects the
“Properties Window”
on page 50 as the
active window.

 Welcome None available Displays the
Welcome tab, which
contains quick links
to create an
environment and set
up your server.

 Reset Workspace
Layout

None available Restores the layout of
your windows and
tabs to the default
factory settings.

 Close Ctrl + F4 Closes the active
window.

3.8 Help menu
The Help menu provides information about what is currently installed within
Output Transformation Designer, and access to the online help guide.

Icon Menu Command Keyboard Shortcut Description

 Help Contents Shift + F1 Opens the online
help in an internet
browser window.

3.8. Help menu
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Icon Menu Command Keyboard Shortcut Description

 About None available Opens the About
window, displaying
the software version
and copyright
information, as well
as information about
your virtual machine
(VM) setup and
product licensing.
For more
information, see
“About Output
Transformation
Designer
Licenses“ on page 7.

3.9 Toolbars
The toolbars permit quick and easy access to frequently used menu commands. You
can customize your graphical interface by hiding toolbars that are seldom used by
navigating to View > Toolbars to toggle on or off which toolbars you want to
appear.

3.9.1 File toolbar

Icon Menu Command Description

New Starts a new project without
closing any projects already
open in Output
Transformation Designer.

Open Opens a project from your
file system without closing
any projects already open in
Output Transformation
Designer.

Save Saves the current project
component to disk. You will
be prompted for a project
name if not already given.

Save As Allows you to save the
current project in a different
folder, or using a different
name.

Save All Saves all components of the
current project to disk.
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Icon Menu Command Description

Print Prints the template file of the
current project.

3.9.2 Edit toolbar

Icon Menu Command Description

Cut Removes a selected item and
saves it to the clipboard.

Copy Saves a copy of selected
item(s) to the clipboard.

Paste Pastes the saved content of
the clipboard to a selected
location.

Delete Deletes the selected item.

Undo Removes the last
modification performed and
reverts it to the previous
state. Where available, the
undo feature is limited to the
last 5 steps.

Redo Redoes the most recently
undone action in the current
project.

Find Searches for a string of
alphanumeric characters
within the opened project.

3.9.3 View toolbar
The View toolbar applies to Data Transformation Engine projects.

Icon Menu Command Description

Hide/Show Mapping Lines Toggles the mapping lines on
and off.

MGP Settings and Details Opens the Data
Transformation Engine
project Settings and Details
form. For information about
this form, see OpenText
Embedded Data Transformation
Engine - User Guide
(VDTOTS-H-UDT).

3.9. Toolbars

VDTOTS240200-UTD-EN-1 User Guide 41



3.9.4 Build toolbar

Icon Menu Command Description

Compile Compiles the selected
component.

Debug Debugs the selected
component.

Execute Executes the commands
within a selected component.

3.9.5 Debug toolbar
The Debug toolbar is not displayed by default. Choose View > Toolbars > Debug to
enable it.

Icon Menu Command Description

Stop Debugging Stops the debugging process.

Continue Debugging Continues the debugging
process.

Step Over Moves to the next process.

Step In Opens the nested process
flow in another editor for
debugging.

Step Out Steps out of the nested
process flow and goes back
to the outer process flow.

3.9.6 Run toolbar
The Run toolbar applies to Data Transformation Engine projects.
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Icon Menu Command Description

Transform from source to the
current target

Allows you to view the
output produced according
to your project's current
configurations. The output is
displayed in the Target
Result tab of the Transform
Target Pane.

Note: If you have
multiple output targets
within your project, the
transformation is
performed only for the
output target currently
selected, since the
Transform option is
meant only to help you
verify your
transformation
settings. All output
targets will be handled
when you do your run-
time transformation.

Transform to multiple JDBC
targets

Transforms all targets instead
of transforming individual
targets.

Shows the report on HTML
browser

Click to see the mapping
details in HTML format in a
browser window.

Packages the project files into
a zip file

Packages all files used in the
project to a zip file in your
preferred location.

3.9.7 ParmDef Editor toolbar

Icon Menu Command Description

Add variable Adds a variable to a ParmDef
class array.

Remove variable Removes a variable from a
ParmDef class array.

Compile Compiles the ParmDef Java
code for variables to a
ParmDef class array.

3.9. Toolbars
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Chapter 4

Output Transformation Designer Windows

The Output Transformation Designer interface is split into five areas:

• “File Systems Window” on page 46

• “Properties Window” on page 50

• “Development Window” on page 54

• “Palette Window” on page 56

• “Events Window” on page 57

You can drag and drop the windows and tabs within Output Transformation
Designer and dock them elsewhere in the application window to customize your
workspace. The size of windows and tabs can also be adjusted to increase their
viewable area. Individual windows can be enlarged to fill the entire screen by
clicking their respective Maximize button, . Then, to restore a window to its
previous size, click the Restore button, .

If you have customized your workspace and are subsequently having problems
locating a specific window or tab, resetting the layout to the default settings can
help. The Window > Reset Workspace Layout command restores all tabs and
windows to the factory default.
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Figure 4-1: Output Transformation Designer default workspace layout

4.1 File Systems Window
The File Systems window contains the “File Systems Tab” on page 47, the
Connections tab, and if a project is currently open, a tab containing the available
resources for the current open project file.

• The File Systems tab contains the resources required for solution development.

• The Connections tab displays all your system's configured deployed and
undeployed OpenText servers.

• The current project tab displays all the available resources for the current open
project.

You can use the  button to access hidden tabs if they do not fit on the screen.
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4.1.1 File Systems Tab
The File System tab displays where your resources and configurations are stored.
File systems can be local or network directories, compressed files, either ZIP or JAR,
relational databases, or content storage systems. Resources are categorized and
sorted into folders. Resources that do not fall into one of the categories appear
uncategorized below all of the folders.

The File Systems tab of the “File Systems Window” on page 46 is where the file
systems are displayed and managed. You can consult the following topics for more
information about working in this window:

• “File System Functions” on page 48

• “Mounting a File System” on page 50

• “Unmounting a File System” on page 50

If you have accidentally closed the tab or cannot locate it for any reason, you can
navigate to Window > File Systems to either reopen or set focus on the tab.

Figure 4-2: Output Transformation Designer File Systems tab

4.1. File Systems Window
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4.1.1.1 File Systems Tab Options

Icon Command Description

Collapse All Collapses the tree view of the
file system from the selected
folder.

Logical View Click to expand a process
flow and see all the process
within the flow.

Link with Editor Click to automatically select
the proper node in the tree
view each time you click a
different editor.

4.1.1.1.1 File System Functions

The following context menu functions are available by right-clicking a folder in the
“File Systems Window” on page 46.

Function Shortcut Description

New Ctrl + N Creates a new component or
folder. The new component
or folder will be nested in the
folder it was created under.

Mount  Mounts a file system of the
following types:

• Local directory

• Compressed file

See “Mounting a File
System” on page 50.

Unmount  Unmounts a selected file
system.

Refresh F5 Refreshes the file system
directory view.

Deploy  Deploys a selected file
system to a connected server.

Explore  Opens the Microsoft
Windows Explore window to
the selected folder.

The following context menu functions are available by right-clicking a file in the
“File Systems Window” on page 46.
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Function Shortcut Description

View as Type  Allows you to associate the
selected file type with a
viewer.

Open Ctrl + O Opens the selected file in the
Development window.

Execute  Executes the process or
event.

Note: : This option is
only available for
processes, process
flows, and events.

Mount  Mounts a file system of the
following types:

• Local directory

• Compressed file

See “Mounting a File
System” on page 50.

Compile F9 Compiles a Java file.

Note: : This option is
only available for Java
files.

Clone  Creates an exact duplicate of
the selected file named
<originalName>_date_
time_
incrementalNumber.<file
Ext>.

Delete Delete Deletes the selected file.

Rename F2 Allows you to rename the
selected file. Do not enter a
file extension as the new
filename will be appended
automatically with the
original file extension.

Refresh  Refreshes the file system
directory view.

Deploy  Deploys a selected file
system to a connected server.

Explore  Opens the Microsoft
Windows Explorer window
to the selected folder.

4.1. File Systems Window
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4.1.1.1.2 Mounting a File System

To mount a new file system:

1. In Output Transformation Designer, right-click anywhere in the File Systems
window.

2. From the context menu that appears, hover over Mountand then select the type
of file system you wish to mount. You can choose from either Local Directory
or Archive.

The Mount File System dialog window opens on the tab of the type of file
system you selected.

Note: The tabbed display enables you to select other types of file systems
once the Mount File System dialog is open.

3. Navigate to the directory or archive you would like to mount. Then either select
it or manually type the name in the Folder Name field for a local file system, or
the File Name field for an archived file system.

4. When you are finished, click Mount.

Output Transformation Designer builds the new file system and your selected
local directory or archive is mounted as a file system.

4.1.1.1.3 Unmounting a File System

To unmount a file system, right-click the unwanted directory or archive and from
the context menu that appears, select Unmount.

4.2 Properties Window
The Properties window contains a list of the parameters for the selected project
component, if available. Explanations of each parameter are provided in the message
area at the bottom of the window.

The Properties window has two distinct areas:

• “Parameter List” on page 51

• “Parameter Definitions Area” on page 52

If you have accidentally closed the tab or cannot locate it for any reason, you can
navigate to Window > Properties to either reopen or set focus on the tab.
Alternatively, you can also right-click a component in the “Development Window”
on page 54 and select Properties from the context menu.

In the figure below, the Properties window is displaying the parameters and values
of a new instance of MailProcess that has been selected in the File System window.
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Figure 4-3: Output Transformation Designer Properties window

Parameter List

You can edit the parameters within the Properties window. There are three types of
parameters:

Icon Description

Normal. These parameters have one
attribute.

Multiple. These parameters have more than
one attribute available to be set.

To expand or collapse the attribute list,
double-click the multiple parameter.

4.2. Properties Window
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Icon Description

List. These parameters have a list of multiple
parameters. Each parameter in the list may in
turn be a Multiple Parameter or a Normal
Parameter. Right-click the list’s value field to
add or remove an additional parameter.

To expand or collapse the attribute list,
double-click the list parameter's name.

Parameter Definitions Area

When an individual parameter is selected in the Properties window, a description of
the parameter is displayed in the Parameter Definitions area located at the bottom
of the Properties window. The Parameter Definitions area explains the use and
syntax of the selected parameter, attribute, or element.

To alter the size of the Parameter Definitions area within the properties window,
place your mouse pointer on the bar between the Parameters list and the Definitions
area, and drag it up or down.

Editing Parameters

A basic set of parameter values are established whenever you add a component. You
can specify additional parameters or change the values for the parameters that have
already been set.

If you need to make changes to components after their creation, or if you prefer to
skip component wizards and enter parameter values yourself, you may do so in the
Properties window in a number of ways:

• Editing the field in the parameter’s respective Value column.

• Selecting the parameter’s ellipses, , and making your changes in the
Property dialog box that opens. For some parameters, the Property dialog box
displays a simple wizard to help you configure specific values such as adding
resources to a resource category. However, there is more flexibility for most
parameters because in the Property dialog box you can choose the format for
how you want to enter parameter values by clicking the existing format type to
display a list of the formats. You can choose from:

– Expression. Accepts parameter values as regular expressions. To assist with
building your expressions, various Functions, split up by Category, are
displayed as well as a list of Variables you can use.

– JavaScript. Accepts parameter values in the JavaScript programming
language.

– Text. Accepts parameter values as a text string.

When switching between different formats, any existing values are translated
into the other format.
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Figure 4-4: Property dialog box displaying Value formats list

Parameter Characteristics

This section discusses key characteristics about working with parameters.

Case Sensitivity

Parameter names and their values are not case sensitive, but are documented in
mixed case for readability. If a value must represent lowercase characters, you must
enclose it in single quotes.

On/Off Versus Yes/No

Some parameters are set using On/Off values while others use Yes/No. Even though
only Yes and No are documented, for compatibility:

• On is the same as Yes (true).

• Off is the same as No (false).

In the Output Transformation Designer interface, On/Off or Yes/No states are
represented by:

• Check boxes being selected or cleared:

• – A check mark in a box indicates the Yes, On, or True condition.

– No check mark means Off, No, or False.

• Radio buttons being activated or deactivated. An activated radio button
indicates the Yes/On condition and the value for that parameter will be used.

Parameter Descriptions

Click on a parameter name to see a description of that parameter in the definitions
area of the window. The Parameter Definitions Area explains the use and syntax of
the selected parameter, attribute, or element.

4.2. Properties Window
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Some parameters have multiple values that can be set. To view additional parameter
attributes, click the plus (+) sign to the left of the parameter name. The list of
additional possible values will drop down. Clicking a minus (-) sign will compress
the parameter details.

Parameter Values

Click the Value field to see the acceptable values for that parameter. If there are a
several valid values:

1. Click the drop-down list arrow to view a list of valid values.

2. Select a value. The value is inserted into the Value field.

Note: Remember to save your component or the changed parameters will not
be applied to your file.

4.3 Development Window
The Development window is where resources are opened and project development
is carried out. Processes and process flows are created in this window. If you have
multiple product modules installed, you can easily switch from one product to
another by selecting the corresponding tab in the Development Window.

In the Output Transformation Designer Development window figure below, a
Process Flow tab is selected in the Development window.

Figure 4-5: Output Transformation Designer Development window
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4.3.1 Designer Layout Options

Figure 4-6: Layout options

The Zoom tool allows you to enlarge the graphical representation area to see details
clearly, or to zoom out to view a complex process flow without having to scroll.
Enter a percentage value, or select to use the sizing tool.

You can manually arrange the icons, or you can use one of the four available
automatic layout options:

• Layered Layout creates a top-down, centred process flow layout.

• Layout Right creates a right-to-left process flow layout.

• Layout Left creates a left-to-right process flow layout.

• Force Directed Layout applies an evenly spaced grid-aligned layout to the
previous layout option chosen.

Click Show/Hide link labels to disable/enable arrow notations.

If you want to manually align processes for a more uniform look, use the grid.

• Choose Dot Grid, Cross Grid, or Line Grid.

• Choose No Grid to remove the grid from view once your layout is complete.

4.4 Welcome Tab
When Output Transformation Designer is first started, the Welcome tab is shown in
the Development window. This tab displays links to help and useful functionality
related to the specific OpenText products you have installed.

To display the Welcome tab after closing it, select Show Welcome from the “Help
menu” on page 39.

4.4. Welcome Tab
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Figure 4-7: Output Transformation Designer Welcome tab

4.5 Palette Window
The Palette window contains the components available for your projects. They can
be simply dragged and dropped into a process flow. The look of the window
depends on the OpenText product you are working with. For example, when
building process flows in Output Transformation Server, the palette window is a
tree view, and when creating projects in Output Transformation Engine, the palette
displays icons and tabs.

Figure 4-8: Palette window in Output Transformation Engine
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4.6 Events Window
The Events window displays messages generated by Output Transformation
Designer as a solution is being created. There are three types of messages shown:

• Warning

• Exception

• Information

If you have accidentally closed the tab or cannot locate it for any reason, you can
navigate to Window > Events to either reopen or set focus on the tab.

Figure 4-9: Output Transformation Designer Events window

4.6.1 Additional Event Window Tabs
Additional tabs may be available depending on which OpenText Output
Transformation Suite solutions you have installed. Refer to product-specific guides
for more information.

4.6. Events Window
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Chapter 5

Output Transformation Designer Environments

An Output Transformation Designer Environment is a collection of mounted file
systems, relevant application files, and resources that are used to build an OpenText
solution. Resources include events, process flows, processes, and Data
Transformation Engine projects.

An Environment is also the output that is deployed to the following platforms:

• HP UX

• IBM AIX

• Sun Solaris

• Linux

• Microsoft Windows Servers

The Environment can be compressed into a single file to aid portability and
deployment across platforms. The compressed Environment will need to be
manually decompressed once it reaches its target system.
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Chapter 6

Components

Components are configurable resources that form the basis of an OpenText Output
Transformation Suite solution. Components can be added to the “Development
Window” on page 54 and linked together as required.

Topics covered in this section include:

• “Creating Components” on page 61

• “Opening Components” on page 61

• “Viewing the XML Source of a Component” on page 62

• “Modifying a Component” on page 63

6.1 Creating Components
To create a component, please refer to OpenText Output Transformation Server - User
Guide (VDTOTS-H-UGD).

6.2 Opening Components
To open a component:

1. Right-click the component and select Open, or drag the icon into the main
window.

2. The component will open in its own tab and when selected, its properties will
be shown in the Properties window as shown below.
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Figure 6-1: Component Properties

6.3 Viewing the XML Source of a Component
You can view the XML source code of any component in the Development window.

To view the XML source:

1. If the component is not already open in the “Development Window”
on page 54, right-click it in the “File Systems Window” on page 46 and select
Open.

2. Ensure the component is the active tab in the Development window.

3. Click the Source tab below the Development window (see the image below).
The XML source code replaces the design view.

4. Click the Designer tab to return to the design view.
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Figure 6-2: XML Source of a Component

6.4 Modifying a Component
The following table details actions that can be performed on a component. Some of
these options are also available from the toolbar, while others are accessed by right-
clicking the component in the workflow. This table describes all possible actions, but
the actions available to a specific component may not include all these options.

Function Description

Open Opens the component configuration wizard
and properties form.

View Resources Opens the Output Transformation Engine
component resources in a new window for
editing.

Page View Opens the Output Transformation Engine
parser component page view. The Page View
details all parser information about the
component.

Annotate Opens an edit box to allow you to add
informational notes to the component as
required.

6.4. Modifying a Component

VDTOTS240200-UTD-EN-1 User Guide 63



Function Description

Cut Cuts the component to the system clipboard.
The component, with all its current
parameter settings can then be pasted into
another process flow or project.

Copy Copies the component to the systems
clipboard. A copy of the component, with all
its current parameter settings can then be
pasted into another process flow or project.

Paste Pastes a cut or copied component from the
systems clipboard.

Clone Creates a duplicate of the component in the
current process flow or project.

Remove Removes the component from the process
flow or project.

Show Source Opens the source code of the selected
component in a new editing window.

Show Mappings Opens the Source and Result Mappings
dialog to view or edit job variables and
source and result XDocs.

Properties Opens the component configuration wizard
and properties form.

Debug Debugs the selected component.
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Chapter 7

Output Transformation Designer Logging

Logs for Output Transformation Designer are written to the application.log file.
This log file is located in the C:\Users\<user_account>\.ots directory, with the size
of the file being user configurable and truncated at 1 MB by default. On Unix and
Linux operating systems, the file is stored in the ~/.ots/logs folder. The log file can
also be accessed through Output Transformation Designer by navigating to View >
Log.

Some messages are also output to the Events Window, but the full logging messages
are written to the log file.
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